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Chapter 1

Introduction
This chapter provides an overview of the Map34 software features and capabilities.

ongratulations on the purchase of the Map34 graphical mapping software. Map34 is simple, easy to 
use visual mapping software for the Loop Telecom AM3440 A, B, C and D multi-services cross 

connect platforms. By default, the AM3440 uses a VT100/telnet user console for card configuration, 
system configuration, mapping, etc. As more cards are added to the AM3440 platform, cross connecting 
(mapping) DS0s can become confusing and time consuming using the serial/telnet console. Map34 
provides clarity using graphical representation, speeds up cross connect mapping and documentation.

C

Productivity Software for AM3440 Configuration

Map34 software is productivity software with graphical mapping. Map34 is a craft tool that  fills the gap 
between the serial/telnet console and complex network management and circuit provisioning systems.

Configure AM3440 Cards

Map34 is used for the TSI (Time-Slot Interchange) cross connect, commonly called “mapping”. Card 
system configuration is performed using the serial/telnet console port. For example, T1 framing and line 
build out, router card configuration, voice card dB levels, etc., are configured using the console port.

Map34 Export and Import Functions

Map34 software has a map export and import function. TSI (Time-Slot Interchange) cross connect maps 
can be exported in a comma delimited (csv, or comma separated values) format for import into 
spreadsheets or in text form for word processors. Create system documentation quickly and efficiently with
the export function. Spread sheet files may be modified off line and imported back into the AM3440, 
creating or modifying the time-slot cross connect map. User added rows beginning with “#” are ignored 
on import.  Additional descriptive columns can be added after the 10 columns that contain the 
mapping data.

Windows Compatibility

Map34 is a 32-bit Windows application.  It is compatible with both 32-bit and 64-bit versions of Microsoft 
Windows XP, XP-Pro, Vista, 7, 8, and 10.

Map34 Licensing

Map34 software is licensed per controller. Each AM3440 requires one or two license keys, one per 
controller. One license file (.lcf) is created per AM3440. Once Map34 and a license is purchased, it can be 
distributed to an unlimited number of PCs and used by an unlimited number of technicians on that 
AM3440. Licenses are available from DCB and can be granted almost immediately using email.

Map34 software accesses the local license (.lcf) file each time a connection is made to an AM3440.
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Map34 Enterprise Licensing

Map34 software is also available under an enterprise license agreement.  Once an enterprise license is 
activated, it is not necessary to configure a per controller license.  Please contact your DCB sales 
representative for details.

Map34 and SNMP Version 1 or Version 3

Map34 uses SNMP commands to communicate with the AM3440. Therefore, Map34 requires an Ethernet 
connection to the AM3440. Map34 supports both SNMP Version 1 and SNMP Version 3. (The AM3440 
does not support SNMP Version 2.) SNMP Version 3 uses authentication keys for secure connections.

Demonstration Version

For demonstration purposes, Map34 is available with a 30 day demo license. Please contact either your 
DCB sales representative, call DCB at 217-897-6600, or send email to: sales@dcbnet.com.

Map34 Applications

Map34 is an ideal tool for telecommunications technicians who work with the Loop AM3440 products.  
The learning curve for mapping the AM3440 is dramatically reduced. Accuracy is increased.  

Once an AM3440 is in service, changes are intermittent. Graphical representation of the mapping and the 
simplicity of the visual process makes recall of the mapping process much faster.

Copies of the Map34 software can be distributed to an unlimited number of users. The software license is 
per AM3440 unit/controller. License files can be duplicated and used on any number of PCs.    

Other Features

Visual Highlight and Click Mapping

To map a DS0 or multiple DS0s, DS0s to be mapped are highlighted and the “Map” button is clicked.     
Un-mapping uses the “UnMap” button. Analog DS0s are visually differentiated from digital DS0s.

Saves Time 

Every DS0 mapping operation reduces a couple of dozen terminal key presses to a simple highlight and 
click operation. Visual mapping can save hours of mapping for a loaded AM3440A chassis.

Increases Accuracy

Links between feature cards are visually displayed. The visual display with varied colors is much easier to 
understand than row and column presentation of DS0 mapping.

Auto-Selection of Voice or Data

 The mapping software automatically selects voice or data when low speed feature cards are mapped. E&M
cards are unique. E&M cards can be set to voice or data, whether set to Transmit Only (TO) or Tie Line 
Types I through V.

Change CAS OFF to ON Without Tedious Re-Mapping

Map34 stores the current mapping, next un-maps everything, changes the CAS setting, then re-maps 
automatically. 
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Short Learning Curve

Visual mapping is more intuitive. More of the mapping options are on the single mapping screen.

Small Program Footprint

The mapping software is a small, efficient program. Users can open multiple program copies when 
configuring multiple AM3440s to better visualize the communications links.

Chapter 2

Installing the Map34 Program
This chapter details the installation process.

Overview

Map34 comes as in installer file for Microsoft Windows XP, Vista, 7 and 8. To install the software, execute
the file with a name similar to “Map34_v1_11.exe”. Please follow the on screen procedures to complete 
the installation. The following three questions will be asked during the installation process: acceptance of 
the End User License Agreement (EULA), the installation location of Map34, and if the creation of a 
desktop icon  for Map34 is desired. 

Installation

Run Map34_v1_11.exe File

Run the file “Map34_v1_11.exe”. The displayed screens are listed  in sequence below. Follow the on-
screen instructions. NOTE: If an older version of Map34 is already installed on your system, it is not 
necessary to remove it before installing a newer version of Map34.
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The license agreement must be accepted to continue the software installation.
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Select the destination location for the program file or accept the default location.
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Choose the location to install the program's shortcuts or select the default location.  
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Choose whether or not to create a desktop icon.
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Click on “Install” to proceed with the program installation. The program typically installs in less than a 
minute.

The program is now installed. If the box “Launch Map34” is checked, the program will be launched when 
the “Finish” button is clicked.

9



Map34 User’s Guide

Start the Map34 Program

 Click on the screen icon or run Map34 from the Program Manager.  
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Chapter 3

Creating License Files
This chapter describes the process for creating license files. A license file is required for 
each AM3440 that is managed.  

Overview

License files are created for each AM3440 unit. An AM3440 has one or two controllers. The controller 
serial numbers are used  to create a 16 digit license key. The serial number(s) and the 16 digit license key 
are used to create the license key file (lcf). One .lcf file is created for each AM3440.
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Edit Device Configuration 

Basic information is entered in the Edit Device Configuration screen.  

Entering Device Configuration Information

1. Enter the IP address of the AM3440

2. Select SNMPv1 or SNMPv3.  The details entered must match the AM3440. For example, for 
SNMPv1, the Get Community and Set Community must match between the .lcf file and the AM3440. 
For SNMPv3, context, user name and keys are required.

3. Enter the controller serial number(s) and the controller license key(s) provided to match that 
Controller card serial number.

4. The “Edit Device Configuration” screen has an option to probe the AM3440 for the controller serial 
numbers. The serial numbers can also be obtained from the serial/telnet screens of the AM3440.
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Completed Device Configuration Screen

The sample Edit Device Configuration screen below has the controller serial number and license key 
entered into the fields near the bottom of the screen. 

Click on the Save button to complete the configuration.
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Chapter 4

Using Map34
This chapter describes how to use the Map34 program.

Overview

There is a single main screen for mapping operations. See chapter 6 for ULSR (SONET type ring topology 
for T1/E1) mapping, which uses a different screen. The Map34 main screen showing a partially populated 
AM3440 is shown below. The illustration is annotated with explanatory notes and arrows in red.

Map34 Main Screen Annotated
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Drop-Down Menus

File Menu

The File menu has options to Select Device, Export Map, Import Map, PrintScreen, Transfer, and Exit 
the program.

1. Select Device will open the same window the users sees when the Map34 program is initially 
opened.  Options are to Connect to Device, connect to a New Device (generating a new license 
key file), Edit Device (an existing device license key file), Browse for an existing license key file, 
or Exit the program.

15



Map34 User’s Guide

2. Export Map exports the map in comma separated value (csv) format or text (txt) format and can 
include assigned time-slots, unassigned time-slots, or both.  

The map, after the .csv file export, formatted in a spread sheet, looks like the sample below:

3. Import Map imports the map from a csv spreadsheet. The imported map must be in the same 
format as it was exported. It is recommended that a map be exported and examined to see the 
format required for a map to be imported. A sample of the exported map as expressed in a spread 
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sheet is illustrated above. Comment rows beginning with “#” can be added. Additional descriptive
columns can be added after column “J”. The added “#” rows and descriptions following column J 
are ignored on import. The Import Map feature provides a way for a map to be modified off line, 
to be restored to an earlier version, to be moved to a different unit, etc. Selecting Import Map 
brings up a standard Windows file selection menu as shown below. This may differ slightly based 
on view options.

4. PrintScreen sends a snapshot of the Map34 window to a printer.

5. Transfer contains a sub-menu that facilitates: a) saving and loading configuration files for both 
the AM3440 itself, as well as RTR-A and 8RT-B plug-in cards (if installed), and b) installing new 
firmware for the AM3440 and for certain plug-in cards that might be installed in the system. 
NOTE: The AM3440 used in the examples below contains an 8 port Router-B (8RT-B, RTAB) 
card.

Get System Configuration save (“get” from the AM3440) the working AM3440 configuration as a .cfg file
and save to your PC using Map34's internal TFTP server. This .cfg file contains user accounts, group 
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accounts, and passwords. System configuration files include the current TSI mapping. Router A and B 
cards, however, are unique and sufficiently complex to require most of their configuration to stay on the 
card, rather than in the controller. Only the TSI mapping from Router A and B cards to other cards is stored
in the controller. There is a separate process for Router A and B configurations. See below. NOTES: a) If 
another TFTP server is already running on your PC, shut it down before completing this operation. b) A 
pop-up window may appear requesting approval to unblock the TFTP port in Windows Firewall.

Send System Configuration load (“send” to the AM3440) a .cfg configuration file into the AM3440.

Get RTAB Startup Configuration save the startup configuration of 8RT-B (RTAB) plug-in card(s) to a file
on your PC.

Get RTAB Working Configuration save the working (currently running) configuration of the 8RT-B 
(RTAB) plug-in card(s) to a file on your PC. NOTE: If changes to the working configuration file are not 
saved, it is possible that the working configuration and the startup configuration are different. 

Send RTAB Configuration load a configuration file into the 8RT-B (RTAB) plug-in card as the startup 
configuration.

Send Controller Firmware loads firmware into the AM3440.

Send Card Firmware loads firmware into selected plug-in cards.

6. The following plug-in cards are supported for firmware upgrades through Map34:

8RS232RJ 8RS232DB DTU-10 DTU-6 8-EM

12FXS 12FXO Q-E1 Q-T1 V.35-A

V.36-A X.21-A GSHDSL-2 GSHDSL-4 RTR-A

8RT-B RS232-8 TDMoE 8DBRA 8UDTE

Tools Menu

The Tools menu has options to Retrieve a TSI map, Clear TSI Map, Refresh the TSI map, configure 
ULSR Mapping, open a Telnet Console connection, and open a Serial Console connection.
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1. Retrieve issues a command to the AM3440 to perform a retrieve operation. This is the same as 
"retrieve" in the serial/telnet main screen option V – Store/Retrieve Configuration “retrieve” 

sub-command. The AM3440 re-reads the last stored configuration. After the retrieve operation 
completes, the Map34 software will automatically do a refresh.  

2. Clear TSI Map wipes out the TSI map (current map, Map 1, 2, 3 or 4 as shown on the top right 
hands side of the Map34 screen) and returns that map to a completely un-mapped state. 

3. Refresh causes the Map34 software to re-read the map from the AM3440. This comes in handy if 
the user goes in with the serial/telnet console and directly modifies the map. It is also useful if 
there is a communication error between the Map34 software and the AM3440 and Map34 gets out
of sync. Some of the Map34 error messages will instruct the user to do a refresh. 

4. ULSR Mapping is used to map ULSR – PDH rings. This choice opens a special mapping window 
for ULSR mapping only. See chapter 6.

5. Telnet Console  opens a telnet session with the AM3440.

6. Serial Console probes the COM ports and virtual COM ports (for example, if a USB to serial 
adapter is being used) to facilitate a direct serial connection to the AM3440's console port.
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Map Menu

The Map menu allows selection of Map1, 2, 3 or 4. The AM3440 has up to 4 maps. Only one of the maps 
is working at any time. Most applications use only Map 1. More than 1 map may be used if there is a need 
to work on a new map without disturbing a current working map. Maps can also be operational by time of 
day or night. For example, one map may be used during the day to carry primarily voice traffic. At night, a 
different map may be desired to increase bandwidth for data transfer.

The current map being managed by the Map34 software is shown in the upper right of the main screen.

 

Help

The Help drop-down menu has an About selection that displays the current software version of Map34.

20



Map34 User’s Guide

AM3440 Chassis Image

Near the top of the Map34 screen is an image of the AM3440 chassis. Across the top is the chassis type, 
which can be A, B, C or D, the IP address, and the name from the SNMP system setup screen. The A, B, C 
and D chassis will be shown in their approximate dimensions. The A chassis is 5U, the B is 2.5U, the C is 3
U, and D is 2 U. 

The A, B, C and D slots shown on the left of the chassis below for are “mini-cards”. The slots numbered 1 
through 12 are the “single slot cards”.  An AM3440 can have 1 or 2 Controller cards, labeled “Controller-
1” and “Controller-2” below. Each chassis can have 1 or 2 operational power supplies. If a power supply 
slot is empty, not powered up, or has failed, the chassis image below has the label “fail”, as shown in the 
lower left, below.
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Picking a Card Slot with a Mouse Click

Below is a partial image of the Map34 screen. Note the red slot B FOM card and the green slot 1 Q-T1 
card. A left-click will populate the horizontal upper card (below the chassis), a right-click will populate the 
lower card near the bottom of the screen. The selected card and the horizontal representation of the card 
slots are color matched. Green on top matches the Q-T1, red on the bottom matches the FOM card.

22



Map34 User’s Guide

Picking a Card Slot - Time-Slot Drop-Down Boxes

Click on the box with the mouse. Move the mouse over the desired slot and left-click. If the box is 
highlighted in blue, scrolling a mouse wheel will scroll through all the registered cards.

Picking a Card Port - Time-Slot Drop-Down Boxes

If the card slot has multiple ports, click on the port box. Move the mouse over the desired port and click.  If
the box is highlighted in blue, scrolling a mouse wheel will scroll through all the available ports. Some of 
the cards with multiple ports include the Q-T1, Q-E1, FOM, TDMoE, 8DBRA, GDSL, LS Optical, etc.
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Turn CAS ON or OFF “On the Fly”

Map34 software allows CAS to be changed from CAS OFF to CAS ON, and ON to OFF “on the fly”.  
Below, CAS for the Q-T1 card should be ON. A left-click on the “CAS is off!” button will change the CAS
from OFF to “CAS is ON”.

This is a significant improvement and huge time saver for users new to the AM3440, or users who may 
have been in a hurry to map and forgot to turn CAS ON in the serial/telnet card slot configuration screen. 
The serial/telnet console requires the map to be manually cleared, then re-entered, if CAS needs to be 
changed.  Map34 can change CAS from OFF to ON automatically with a single click.
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Selecting Time-Slots to Map

Select the time-slots to map by highlighting them. Hold down the left mouse key and slide over the desired 
time-slots. The time-slots will be highlighted in a darker gray. The same number of slots must be picked on
the top and the bottom cards.   

Automatic Selection of Voice or Data for Low Speed Cards

Low speed cards are non-transport cards. Voice low speed cards are FXS and FXO. Data low speed cards 
include the DTE cards, 8DBRA, and 8RS232, Router cards, etc. High speed cards, or trunk circuit cards 
that can have DS0s manually set for Voice or Data include T1, E1, FOM, GDSL, TDMoE. NOTE: E&M 
low speed cards can carry both data and voice. Starting with recent versions of Map34, E&M time-slots 
can be mapped as either “data” or “voice.” “Data” removes robbed bit signaling from the data stream and 
provides a slight improvement of the signal to noise ratio.
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Select Voice or Data for Pass Through Time-Slots

If one transport card is mapped to another (T1 to T1, E1 to E1, T1 over FOM, E1 over FOM, etc.), and not 
directly to a low speed voice a time-slot may or may not carry voice traffic. If the time-slot does carry 
voice traffic, the card must be mapped as voice. If the time-slot does not carry voice traffic, the card must 
be mapped as data. Proper designation of voice or data is required for the voice signaling bits (AB bits or 
ABCD bits) to pass through the system correctly.  Exception: Types I – V and Transmit Only (TO) 
E&M cards may be set as data if the E&M leads will not be used, as the ABCD robbed bits are not 
needed for signaling.  Setting an E&M Types I – V or TO circuit to data will improve the signal to 
noise ratio (SNR) by about 3 dB. NOTE: If an E&M circuit is set to Types I – V, the relays may chatter. 
Relay chatter can be ignored, or can be suppressed by wiring to the appropriate Type.

Below, the dark gray selected time-slots on the T1 to E1 could be voice or data. To the right of the screen 
is the voice or data selection. If the time-slots are passing voice, select voice. If they are 
passing data, select data.
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Bidirectional and 1:N(Multicast) 

The AM3440 can be configured for bidirectional mapping or 1:N(Multicast). This is set in the System 
screen under System Setup, using the serial/telnet console. Below is a snippet from the System screen 
showing the 1: N(Multicast) selection.. If Bidirectional is selected, there is only one map choice. If 
1:N(Multicast) is selected, Map34 shows 3 mapping options: Bidirectional with the up and down arrows, 
or one way with the up arrow or down arrow.

  

1:N(Multicast) mapping can be one direction or bidirectional as shown below. The three choices, up, down
or both up and down, are shown only when the System setting is “1:N(Multicast)”.

Map one way or Bidirectional when the AM3440 system setting is “1:N(Multicast)”

When the System setting in the AM3440 is Bidirectional, only the two-way mapping button appears. The 
AM3440 defaults to Bidirectional.
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Please Note: The CCB, CCPA and later firmware versions of the CCA controller allow unidirectional 
cross-connects even when the system TSI function is set for  “1:1(Bidirectional)”.  If the controller 
supports this feature, Map34 will display the unidirectional and bidirectional map and unmap buttons, 
regardless of the TSI function setting.
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Activate, Store the Map

The map must be Activated to become functional. Store can be optional. Store takes about 30 seconds to 
complete. AM3440 units since about 2008 have an automatic save (store) function that defaults to 300 
seconds, or 5 minutes. Force a store if the AM3440 has older firmware, or if the unit will be powered off 
before the auto-save timer expires. 

The Auto-Save function is accessed through the serial/telnet console. It is under “System Setup”, then     
“L-Command Line”. A sample screen is below:

 

FOM (Fiber Optic Module Cards) and Time-Slot 16

The FOM cards have 31 time-slots for each of the 4 ports. This feature provides the ability for the FOM 
cards to  carry as many s as a full E1. The FOM card also transports time-slots as voice or data. To 
transport voice, the FOM card time-slot must to set to FRAME ON and CAS ON.
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When set to CAS ON to transport voice, time-slot 16 of the E1 is not available for mapping. It is 
automatically selected for signaling. T1 carries the signaling bits (ABCD bits that signal on-hook,          
off-hook, ring, etc.) within the DS0 as inband “robbed bit” signaling. 

See the screen shot below. Note that “ts16” at the bottom on the Slot-B FOM card Port-1 has a red “S” to 
signify that the channel is not available for mapping. It has been automatically reserved for signaling.

UnMap Time-Slots

Click the card images to select the cards, select the port desired if it is a multi-port card. The time-slots 
mapped are shown by the colored lines connecting the time-slots. Highlight the time-slots to be               
un-mapped. Click the UnMap button on the right hand side of the screen. Click “Activate” to activate the 
new map with the time-slots removed.
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Chapter 5

Operations Requiring the 
Serial/Telnet Console

This chapter describes what functions must be done using the serial/telnet console 
configuration functions that are not part of Map34.

Overview

Map34 makes time-slot mapping the AM3440 faster and more accurate and aids in documentation. The 
program is a complement to the serial/telnet console, not a substitute. The following lists some examples of
configuration that must be completed using the AM3440 console. Some screenshots are included.

System Configuration
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SNMP Configuration

SNMP System configuration is via the console.

High Speed Trunk Card Configuration 

T1, E1, FOM, TDMoE and DSL cards are configured using the console.
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Voice Card Configuration

Voice cards, including FSX, FXO, and E&M are configured with the console.

Router Card Configuration

The RT, RTA and RTB router cards are configured using the serial/telnet console. Router A and Router B 
cards also store the router configurations on the router cards themselves, not in the controller configuration.
Use the “Transfer” function under the “File” drop-down menu to get Router A and B configurations from 
the cards or to send stored configurations back into the cards.

Serial Data Card Configuration

Serial data cards require the serial/telnet console for system setup.

DTE Card serial/telnet configuration screen
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8DBRA (serial asynchronous data bridge) serial/telnet configuration screen

35



Map34 Users Guide

Chapter 6

ULSR PDH Ring
This chapter describes the ULSR PDH ring, how to configure the AM3440 to support the 
ULSR function, and how to map the ULSR ring with the Map34 software.

Overview

ULSR is a Unidirectional Line Self-healing Ring. The Loop AM3440 supports ULSR PDH ring 
architecture for T1, E1 and FOM cards. A ULSR ring is similar to a self-healing SONET or STM ring, but 
over T1 or E1. In short, ULSR is a low speed DS1 ring architecture.

It is recommended that the ring be visualized as working clockwise. In the Map34 software, clockwise is 
considered to be easterly, or the out of the East link, while counterclockwise is considered to be westerly, 
or the out of the West link.
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System Configuration

The AM3440 must be configured to support the ULSR Ring. Key items to configure are:

1. The System Configuration must be changed from the default Bidirectional setting to 
1:N(Multicast).

2. ULSR software must be installed in the AM3440.  ULSR software is optional add-in software. 
When purchased, a software key is supplied that activates the ULSR function in the AM3440. 
ULSR software is per controller. Dual controllers require a ULSR software license per controller.

3. When the software is installed, the System Setup – Controller Setup page has an additional option 
“R – PDH Ring Protection.  The “R” option is where the protection is enabled for the AM3440 
and for selected ports.  The main unit is set to Master, the other units in the ring are set to Slave. 
See the screen below:
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ULSR Mapping Tool

The main screen of Map34 software has a drop-down option under “Tools” for ULSR Mapping.

The ULSR Mapping option brings up the screen shown below. Select cards first. The low speed drop cards,
such as FXS, FXO, E&M, Router, serial card, etc. are selected at the top of the screen. The trunk T1, E1 or 
FOM cards are selected at the bottom of the screen. Highlight the desired time-slots, then click Drop if the 
low speed circuit terminates at this location, or Bypass if the circuit terminates at another AM3440 unit.  
Usually voice or data does not need to be selected (except for E&M, which can be voice or data), unless it 
is a bypass DS0 at this location and a Drop card is not selected.

The following diagrams illustrates the cross-connects generated when using the ULSR tool.  The Drop 
button creates 3 unidirectional cross-connects between east, west, and the drop.  The Bypass button creates
a bidirectional cross-connect between east and west.
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Chapter 7

Activating an Enterprise License
This chapter describes the process for activating an enterprise license.

Overview

An enterprise license is an alternate Map34 licensing method.  It eliminates the need to manage per-
controller licenses.  Instead, a single license key is entered into Map34.  Once activated, it is not necessary 
to populate the controller license key fields in the device configuration.  This licensing method is used for 
both enterprise and trial licensing.

Activation

· Start Map34.  The following window will appear.  Press the "Key" button.

· The Enterprise/Trial License Window will open.  Enter the "Issued to" and "Enterprise License 
Key" fields exactly as shown on your Enterprise Software License Key Certificate.
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• Press "OK".  Your copy of Map34 will now operate in Enterprise Mode.
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Chapter 8

Circuit Info Feature
This chapter describes Circuit Info feature available in the 
AM3440 CCB and CCPA controllers and how to set this 
information from Map34.

The CCB and CCPA controllers have the capability to attach Circuit Information to a cross-connect.  From 
the CLI, this information is attached during TSI Map Setup and may be viewed from the TSI Map.  To 
modify the Circuit Information, the user must re-map the cross-connect with the new information.

Map34 supports adding Circuit Information during a map operation.  Circuit Information is entered into a 
text box before pressing one of the Map buttons.
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To view and modify Circuit Information, Map34 provides a “Circuit Info View”.  This view will open a 
second window showing all cross-connects and the attached Circuit Information.
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The Circuit Information window will initially overlay the Main Map34 window.
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The Circuit Information Window does not preempt the Main Map34 Window.  The user may move the 
Circuit Information Window to the side of the Main Map34 Window and freely move focus back and forth 
between the two windows.
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To modify the Circuit Information, select one or more cross-connects, enter the new Circuit Information, 
and press one of the “Apply” buttons.  The new Circuit Information can be applied to the Target side by 
pressing “Apply to Target ←”.
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If the cross-connect is bidirectional, the modified Circuit Information can be applied to both the target and 
source by pressing the “Apply to Target ↔ Source”.  Please note, if the cross-connect is not bidirectional, 
only the Target will be modified.
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The Circuit Information Window also has a search facility to locate a cross-connect based on the Circuit 
Information.  Only the “Target” side is searched and the search is not case sensitive.  

There are two search modes supported.  In normal mode, the search string is always compared with the 
Circuit Info, starting with the first character.  For example, a search string of “Dewey” will match Circuit 
Info “Dewey B1” but would not match “Site Dewey”.
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The other search mode will match on sub-strings.  This means the search string will match any part of the 
Circuit Information.  For example, searching for “B2”  will match “Dewey Station B2”.
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The Circuit Info Window can be used to quickly navigate within the Main Map34 Window.  By double-
clicking on a row in the Circuit Info Window, the Main map34 Window change context to show the 
requested cross-connect.

Circuit Info in CSV export file

The Circuit Information fields have been appended to each row in the CSV export file.  The format of each
row is shown below:

Device_Name, 

Target_Card, 

Target_Slot, 

Target_Port, 

Target_TS, 

Source_Card, 

Source_Slot, 

Source_Port, 

Source_TS, 

Chan_Type, 

Target_Circuit_Info, 

Source_Circuit_Info 
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Appendix A

Specifications

Map34 Specifications

· Map34 works with all versions of the Loop Telecommunications International AM3440 (A, B, 
C, D and E versions) and selected OEM/ODM versions.

· Map34 works with AM3440 CCA, CCB, and CCPA controllers.  For CCA controllers, the 
firmware version must be v8.41.01 or later.

· Map34 runs on Windows XP, XP-Pro, Vista, 7, 8, and 10 both 32 bit and 64 bit, as well as 
Windows 2008R2 (which is 64 bit only).

· Map34 requires a license for each AM3440 controller it supports.

· Map34 may be used by an unlimited number of technicians on an unlimited number of 
workstations.

· Map34 is also available under an Enterprise license agreement.

· Map34 is licensed software owned by Data Comm for Business, Inc., 2949 CR 1000E, Dewey, 
Illinois, 61840, Tel 217-897-6600.

· http://www.dcbnet.com  

· Link to check for upgrades to newer versions: http://www.dcbnet.com/datasheet/map34ds.html

· Map34 v1.16 supports AM3440 CCA firmware released after January 2012 but prior to 
v8.41.01, released in 2015.  Please contact DCB support if you need this specific version of 
Map34.
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